During an interactive SAS session, you can issue commands from the SAS command line. SAS supports many commands that help you navigate your session and accomplish certain tasks. In many cases, the command is simply another way to invoke an action that you can also accomplish by using the SAS menus and windows. However, advanced users might find the supported commands a more efficient way to work, or sometimes a more flexible way to accomplish a task in the event that the parameters of your task are different than what the SAS interface supports.

Most SAS windowing environment commands are described in SAS online Help. The commands that are described here have syntax or behavior that is specific to the Windows operating environment.

The following SAS commands are not supported under Windows:

- PCLEAR
- PLIST
- SCROLLBAR
- SMARK
- WDRAG
- WGROW
- WMOVE
- WSHRINK

These commands are not supported under Windows because it is more efficient to use Windows features. For example, the SCROLLBAR command and window sizing commands are not needed in the Windows operating environment as scrollbars and window sizing bars are an integral part of the graphical user interface.
Dictionary

**AUTOSCROLL**

Controls how often the LOG and OUTPUT windows scroll to display output

Windows specifics: Default values

Syntax

AUTOSCROLL <number-of-lines | PAGE | MAX>

Details

Under Windows, the default value for the AUTOSCROLL command in the OUTPUT window is 0 (meaning that no output is written to that window while statements are executing, which provides the best performance). In the LOG window, the default value is 1.

Scrolling can increase the length of time that the SAS System takes to run your program. The less scrolling that the LOG and OUTPUT windows have to do, the faster that your program will run. The advantage of keeping the AUTOSCROLL setting of the LOG window at 1 is that the SAS System uses the LOG window to notify you of the status of the running program.

See Also

- AUTOSCROLL command in SAS online Help

**AWSMAXIMIZE**

Maximizes the main SAS window

Windows specifics: All

Syntax

AWSMAXIMIZE <ON | OFF>

No argument

toggles the main SAS window between the maximized and the restored state.
ON
maximizes the main SAS window. This option has the same effect as clicking on the maximize button.

OFF
restores the main SAS window to its previous state.

Details
The AWSMAXIMIZE command allows you to enlarge the main SAS window to use the complete Windows desktop.

AWSMINIMIZE
Minimizes the main SAS window
Windows specifics: All

Syntax
AWSMINIMIZE <ON | OFF>

no argument
toggles the main SAS window between the minimized and the restored state.

ON
minimizes the main SAS window. This option has the same effect as clicking on the minimize button.

OFF
restores the main SAS window to its previous state.

Details
The AWSMINIMIZE command allows you to minimize the main SAS window to the Windows task bar.

AWSRESTORE
Restores the main SAS window to its previous state
Windows specifics: All

Syntax
AWSRESTORE <ON | OFF>
no argument
toggles the main SAS window between the maximized and the restored state.

ON
restores the main SAS window to its previous state. This option has the same effect as selecting Restore from the main SAS window's title bar pop-up menu.

OFF
restores the main SAS window to its default state.

Details
You can use either the AWSRESTORE command or the AWSMAXIMIZE command to toggle the main SAS window between maximized and its previous state.

CAPS
Causes characters to be translated to uppercase
Windows specifics: All

Syntax
CAPS

Details
The CAPS command changes the case for text not yet entered or for text modified in a window.
Under Windows, characters are translated to uppercase when you move the cursor off the line or when you press ENTER.

See Also
- CAPS command in SAS online Help

COLOR
Controls the color of window components
Windows specifics: Affected window components

Syntax
COLOR field-type <color | NEXT <highlight>>
**field-type**

specifies the area of the window or the type of text whose color is to be changed.

**color**

specifies a color for the window or for selected portions of the window.

**NEXT**

changes the color to the next available color. The value of NEXT is based on the most recent color entered. The order of the colors depends on your monitor.

**highlight**

specifies the highlighting attribute.

**Details**

Under Windows, you cannot use the COLOR command to change the colors of the following display components: border, menu bar, pop-up menu background, and title bar. Use the Windows Control Panel to change the colors of these display components. In addition, the HIGHLIGHT and BLINK highlight attributes are not supported for any Windows window component.

**See Also**

- COLOR command in SAS online Help

---

**COMMAND**

Sets the options for the command bar or Command dialog box

**Windows specifics:** Valid options

**Syntax**

COMMAND <<WINDOW "<title>" | BAR
<SORT=MCU | MRU><MAX=max-commands><AUTOCOMPLETE | NOAUTOCOMPLETE>>() | CLOSE>

**no arguments**

toggles the command line on and off for the active window.

**WINDOW "<title>"**

specifies to display the Command dialog box. The "title" argument is optional and must be enclosed in double quotes. If you specify title, the Command dialog box appears with title as the title.
BAR

specifies to display the command bar in a stationary location, underneath the menu bar.

SORT=MCU|MRU

specifies how you want SAS to sort the commands that are stored in the Command window list. You can have the commands sorted in the order of those that you most commonly use (MCU) or that you most recently used (MRU).

You must specify the WINDOW or BAR argument on the command before specifying the SORT argument.

MAX=max-commands

specifies the maximum number of commands to “remember” in the Command window list. Valid values are 0 through 50.

You must specify the WINDOW or BAR argument on the command before specifying the MAX argument.

AUTOCOMPLETE | NOAUTOCOMPLETE

specifies whether or not the command bar attempts to match the command being typed with commands previously typed.

CLOSE

specifies to close the command bar or the Command dialog box.

Details

You can set some of these options by using the Preferences dialog box. However, you can specify a title for the Command window only by using this command.

See Also

- COMMAND command in SAS online Help
- “Setting Session Preferences” on page 42
- Command: “DLGPREF” on page 259

---

**CUT**

Cuts selected text from a window

*Windows specifics:* Supported options

**Syntax**

CUT <LAST | ALL>

**LAST**

cuts the most recently marked text and unmarks all other marks when more than one area of text is marked. To cut one area of text when more than one mark exists, you must use either the LAST or the ALL argument.
ALL

cuts all current marks when more than one area of text is marked.

Details

The CUT command removes marked text from the current window and stores it in the Windows clipboard.

Under Windows, the APPEND and BUFFER= options are not supported for the CUT command.

See Also

- CUT command in SAS online Help
- “Using the Clipboard” on page 36
- Command: “WCUT” on page 277

---

DLGABOUT

Opens the About dialog box

Windows specifics: All

Syntax

DLGABOUT

Details

To access the About SAS dialog box from the pull-down menus, select the Help menu and then select About SAS System.

---

DLGCDIR

Opens the Change Folder dialog

Windows specifics: All

Syntax

DLGCDIR
Details
From the Change Folder dialog, you can select a new working directory (or folder).

See Also

□ “Changing the SAS Working Folder” on page 41

---

**DLGCONVERT**

Opens the Convert dialog box

Windows specifics: All

**Syntax**

DLGCONVERT

**Details**

You can use this command from the SAS/AF BUILD window with an OLE object selected. The Convert dialog box lets you convert the selected OLE object from one type to another, with the available types depending on what the OLE server application supports for that object.

See Also

□ “Converting OLE Objects” on page 172

---

**DLGENDR**

Opens the Exit dialog box

Windows specifics: All

**Syntax**

DLGENDR

**Details**

The Exit dialog box prompts you to confirm that you want to exit the SAS System. If you select [OK] in the dialog box, the SAS session ends. If Confirm exit is unchecked in the Preferences dialog box General page, SAS closes when you enter DLGENDR.
**DLGFIND**

Opens the Find dialog box

Windows specifics: All

---

**Syntax**

DLGFIND

---

**Details**

The Find dialog box allows you to search for text strings.

---

**See Also**

- Command: “DLGREPLACE” on page 262

---

**DLGFONT**

Opens the Fonts dialog box

Windows specifics: All

---

**Syntax**

DLGFONT

---

**Details**

The Fonts Selection dialog box allows you to dynamically change the SAS windowing environment font.

---

**DLGLIB**

Opens the Libraries dialog box

Windows specifics: All

---

**Syntax**

DLGLIB
Details

The Libraries dialog box lets you define or modify SAS libraries. The DLGLIB command is supported for compatibility with previous releases.

In Version 7 you can use the SAS Explorer window to browse or assign SAS libraries.

See Also

- Introductory books for SAS for more information about using the SAS Explorer window to manage SAS libraries

DLGLIBMAINT

Opens the New Library or Modify Library dialog box

Windows specifics: All

Syntax

DLGLIBMAINT <NEW>

no argument

opens the Modify Library dialog box.

NEW

opens the New Library dialog box.

Details

The New Library and Modify Library dialog boxes let you define or modify SAS libraries. The DLGLIBMAINT command is supported for compatibility with previous releases.

In Version 7 you can use the SAS Explorer window to assign SAS libraries.

See Also

- Introductory books for SAS for more information about using the SAS Explorer window to manage SAS libraries

DLGLINKS

Opens the Links dialog box

Windows specifics: All
Syntax

DLGLINKS

Details

The DLGLINKS command opens the Links dialog box, allowing you to update a linked object.

See Also

- “Using Linked OLE Objects” on page 171

DLGOPEN

Opens the Open dialog box

Windows specifics: All

Syntax

DLGOPEN <LONGFILTER="filters" | FILTER=\"filters\" \<REPLACE> \>\<SUBMIT | NOSUBMIT> \<IMPORT> \<VERIFY> \<ALTCMD='command'>

no arguments

opens the Open dialog box with the default settings

LONGFILTER="filters" | FILTER=\"filters\"

LONGFILTER="filters" specifies one or more file filters to use as search criteria when displaying files. Multiple filters appear in the combo box in addition to the application specified filters. You must enclose the filter list in double quotes. Note that you can specify long filenames that include spaces and single quotes. Separate each filter that you specify with a vertical bar (|). For example, if you specify

dlgopen longfilter="*.text|*.Bob's work|*.XX"

the dialog box displays all files in the current directory that have .text as their file extension, and the dialog box adds *.text, *.Bob's work and *.XX to the List Files of Type: combo box.

FILTER=\"filters\" specifies one or more file filters to use as search criteria when displaying files. You must enclose the filter list in single quotes. Separate multiple lists with a space. For example, if you specify

dlgopen filter="*.bak *.txt"

the dialog displays all files in the current directory that have a .BAK file extension, and the dialog add *.TXT to the List of Files of Type: combo box.
Note The difference between LONGFILTER="filters" and FILTER='filters' is that with LONGFILTER="filters" you can use spaces and quotes in the filters, where in FILTER='filters' you cannot use spaces and quotes.

REPLACE replaces the filter list with the specified filters instead of concatenating the list with the default filters. This option is valid only when you specify the LONGFILTER= or FILTER= argument as well. For example, the command

```
dlgopen longfilter="*.txt" replace
```

will load the combobox with the *.TXT specification (instead of the default file types).

SUBMIT | NOSUBMIT

specifies whether the Submit check box is checked when the dialog box opens. By default, the Submit check box (which indicates that the contents of the opened file should be immediately submitted as a SAS program) is not checked. You can automatically submit a file when you open the file by selecting Submit contents of file opened from the Preferences dialog box.

IMPORT

invokes the Import dialog box, allowing you to import graphics files into your SAS session.

VERIFY

verifies whether the active window contains a File pull-down menu with an Open item. If it does, the Open dialog box invokes the Open item command instead of invoking the default INCLUDE command.

The VERIFY argument is not valid when specified with ALTCMD or IMPORT.

ALTCMD='command'

specifies the command to be applied to the file that you select. For example, the command

```
dlgopen altcmd='x' longfilter='*.bat'
```

allows you to select a DOS batch file, then runs the batch file in a DOS shell. The INCLUDE command is the default command.

Details

The Open and Import dialog boxes allow you to select a file to read into the active window. To access the Open dialog box from the pull-down menus, select the File menu and then select Open. To access the Import dialog box from the pull-down menus, select the File menu and then select Import.

See Also

- “Opening and Saving Files” on page 28
- “Setting Session Preferences” on page 42
- “Importing Graphics from Other Applications” on page 123

**DLGPAGESETUP**

Opens the Page Setup dialog box
DLGPAGESETUP

Details
The Page Setup dialog box allows you to define page attributes such as paper size, source, orientation, and margins.

See Also

- "Changing the Page Setup Options" on page 109

DLGPREF

Opens the Preferences dialog box

Details
The Preferences dialog box allows you to configure your SAS session to accommodate the way that you like to work.

See Also

- "Setting Session Preferences" on page 42

DLGPRT

Opens the Print dialog

Syntax
DLGPRT <NOSOURCE | ACTIVEBITMAP | SCREENBITMAP | AWSBITMAP |
CLIPBITMAP | CLIPTEXT | ALTCMD='command' | BITMAPONLY |
NODISPLAY | VERIFY>
no argument
prints the active window with the default print settings.

ACTIVEBITMAP
suppresses the Print dialog box and prints the active window as a bitmap.

ALTCMD='command'
uses the Print dialog box to issue a command other than PRINT.

AWSBITMAP
suppresses the Print dialog box and prints the main SAS window as a bitmap.

BITMAPONLY
allows only bitmap printing from the Print dialog box.

CLIPBITMAP
suppresses the Print dialog box and prints the contents of the Windows clipboard as a bitmap.

CLIPTEXT
suppresses the Print dialog box and prints the contents of the Windows clipboard as text.

NODISPLAY
suppresses the Print dialog box and prints using the default settings.

NOSOURCE
prevents the user from specifying a source (application window) from which to print.

SCREENBITMAP
suppresses the Print dialog box and prints the entire screen as a bitmap.

VERIFY
checks to see if the active application window supports text printing (that is, whether the File pull-down menu contains a Print item). If it does not, the Print dialog box allows only bitmap printing.

Details
The Print dialog box allows you to print the contents of the active window.

See Also

  □ “Printing from within a SAS Window” on page 106

DLGPRTPREVIEW

Invokes the Print Preview window

Windows specifics: All
DLGPRTPREVIEW <VERIFY>

VERIFY

checks to see if the active application window supports printing (that is, whether the File pull-down menu contains a Print item). If it does not, the Print Preview window will not be displayed. You can still print these windows as bitmaps. Preview the output by issuing the DLGPRT VERIFY command and then clicking Preview.

Details

Not all SAS application windows support the Print Preview feature.

See Also

- “Previewing Your Output before You Print” on page 113
- “Printing” on page 105

DLGPRTSETUP

Opens the Print Setup dialog box or programmatically sets printer settings

Windows specifics: All

Syntax

DLGPRTSETUP <ORIENT=PORTRAIT | LANDSCAPE><NODISPLAY>

ORIENT=PORTRAIT | LANDSCAPE

sets the default page orientation for the current printer. The orient parameter is to support backward compatibility of SAS. The preferred method to specify the orientation is with the ORIENTATION system option.

NODISPLAY

suppresses the display of the Print Setup dialog box. This option is intended to be used only when you use other options to explicitly set printer settings.

Details

The Print Setup dialog box allows you to name the printer to which you want to print, specify that you want to use SAS forms to print, and to access dialog boxes that control how the SAS System prints information, such as paper orientation, margins, and fonts.
See Also

- “Changing the Print Options” on page 107

DLGREPLACE

Opens the Replace dialog box

Windows specifics: All

Syntax

DLGREPLACE

Details

The Replace dialog box allows you to find a text string and replace it with another text string.

See Also

- Command: “DLGFIND” on page 255

DLGRUN

Opens the Run dialog

Windows specifics: All

Syntax

DLGRUN

Details

The Run dialog box allows you to start another application from within SAS.

DLGSAVE

Opens the Save As dialog box
Windows specifics: All

Syntax

DLGSAVE <LONGFILTER="filters" | FILTER=filters' <REPLACE>> <EXPORT> <NOPROMPT> <VERIFY> <ALTCMD=command'>

no arguments

opens the Save As dialog box with the default settings.

LONGFILTER="filters" | FILTER=filters'

LONGFILTER="filter" specifies one or more file filters to use as search criteria when displaying files. Multiple filters appear in the combo box in addition to the application specified filters. You must enclose the filter in double quotation marks. Note that you can specify long filename extensions that include spaces and single quotes, and each filter that you specify must be separated by a vertical bar (|). For example, if you specify

dlgsave longfilter='*.text|*.Bob's work|*.**XX'

the dialog displays all files in the current directory that have .TEXT as their file extension, and the dialog box adds *.text, *.Bob's work, and *.**XX to the List Files of Type: combo box.

FILTER=filters' specifies one or more file filters to use as search criteria when displaying files. You must enclose the filter list in single quotes. Separate multiple lists with a space. For example, if you specify

dlgsave filter='*.bak *.txt'

the dialog box displays all files in the current directory that have a .BAK file extension, and the dialog adds *.TXT to the List of Files of Type: combo box.

Note: The difference between LONGFILTER="filters" and FILTER=filters' is that with LONGFILTER="filters" you can use spaces and quotes in the filters, where in FILTER=filters' you cannot use spaces and quotes.

REPLACE

replaces the filter list with the specified filters instead of concatenating the list with the default filters. This option is valid only when you specify the LONGFILTER= or FILTER= arguments as well. For example, the command

dlgsave longfilter='*.txt' replace

will load the combo box with only the *.TEXT specification (instead of the default file types).

EXPORT

invokes the Export dialog box, allowing you to export graphics files from your SAS session. For more information about the Export dialog box, see “Exporting Graphics for Use with Other Applications” on page 124.

NOPROMPT

does not prompt the user to replace or append an existing file.

VERIFY

verifies whether the active window contains a File pull-down menu with a Save item. If it does, the Save As dialog box invokes the Save item instead of the default FILE command.
The VERIFY argument is not valid when specified with ALTCMD or EXPORT.

**ALTCMD='command'**

specifies the command to be applied to the file that the user selects. If not specified, the FILE command is applied. For example, the command

dlgsave altcmd='prtfile'

sets the file selected from the Save As dialog box as the current print file. The FILE command is the default command.

**Details**

The Save As dialog box lets you save the contents of the active window to a file.

**See Also**

- “Saving Window Contents to a File” on page 29

---

**DLGSMAIL**

Opens the Send Mail dialog box

**Windows specifics:** All

**Syntax**

DLGSMAIL

**Details**

The Send Mail dialog box lets you send electronic mail while working in the SAS System. To access the Send Mail dialog box from the pull-down menus, select the File menu and then select Send...

**See Also**

- “Using the Send Mail Dialog Box to Send Electronic Mail” on page 140
- Command: “WEMAILFMT” on page 278

---

**FILE**

Saves the contents of a window to an external file

**Windows specifics:** Valid options
Syntax

FILE file-specification <portable-options> <host-options>

file-specification

specifies a valid Windows external file specification as documented in “Referencing External Files” on page 85

portable-options

specifies one or more portable options, which are documented under the FILE command in SAS online Help.

host-options

BLKSIZE=block-size
BLK=block-size

specifies the number of bytes that are physically read or written in an I/O operation. The default is 8K. The maximum is 1M.

HOTLINK

is used only in the context of Dynamic Data Exchange (DDE). For a complete description and an example of using this option, see “Using the DDE HOTLINK” on page 201.

LRECL=record-length

specifies the record length (in bytes). Under Windows, the default is 256. The value of record-length can range from 1 to 1,048,576 (1 megabyte).

NOTAB

is used only in the context of Dynamic Data Exchange. This option enables you to use non-tab character delimiters between variables. For more information about this option, see “Using the NOTAB Option with DDE” on page 200.

RECFM=record-format

controls the record format. Under Windows, the following values are valid:

F indicates fixed format.

N indicates binary format and causes the file to be treated as a byte stream.

P indicates print format.

V| D indicates variable format. This is the default.

Details

The FILE command writes the entire contents of the active window to an external file without removing text from the window.
See Also

- FILE command in SAS online Help
- “Using the FILE Command” on page 99
- For an example of using some of these options, see “Advanced External I/O Techniques” on page 100.

---

**FILL**

Specifies the fill character

Windows specifics: Default character

---

**Syntax**

FILL fill-character

fill-character
- specifies the character to be used to fill out a line.

---

**Details**

The fill characters are placed beginning at the current cursor position. Under Windows, the default fill character is an underscore (_).

---

**See Also**

- FILL command in SAS online Help

---

**GSUBMIT**

Submits SAS code stored in the Windows clipboard

Windows specifics: Valid value for paste-buffer-name

---

**Syntax**

GSubmit BUF=paste-buffer-name | “SAS-statement-1;...SAS-statement-n;”

---

**Details**

Under Windows, if the paste-buffer-name argument is specified, it must be DEFAULT. The Windows clipboard is the default paste buffer.
See Also

- “Using the GSUBMIT Command” on page 100
- GSUBMIT command in SAS/GRAPH Software: Reference

---

**HOME**

Toggles cursor position between current position and home position

**Windows specifics:** Keyboard equivalent

---

**Syntax**

HOME

---

**Details**

Under Windows, the HOME command is equivalent to the HOME key on your keyboard, which toggles your cursor between the last cursor position and the home position in the window.

You can also define a function key to execute the CURSOR command, which positions the cursor at the home position in the window but has no toggle effect.

See Also

- HOME command in SAS online Help

---

**ICON**

Minimizes the active window

**Windows specifics:** All

---

**Syntax**

ICON <ALL>

---

**no argument**

- specifies that the active window be minimized.

**ALL**

- specifies that all windows except the main SAS window be minimized.
Details
If the window bar is active, the ICON command minimizes windows to the window bar. Otherwise, windows are minimized to the application workspace.

Note: Do not confuse this command with the ICON system option, which minimizes the main SAS window.

See Also

ICON command in SAS online Help

---

**INCLUDE**

Copies lines from an external file into a SAS window

Windows specifics: Valid options

---

**Syntax**

INCLUDE file-specification <portable-options> <host-options>

**file-specification**

specifies a valid Windows external file specification as documented in “Referencing External Files” on page 85

**portable-options**

specifies one or more portable options, which are documented under the INCLUDE command in SAS online Help.

**host-options**

BLKSIZE=block-size
BLK=block-size

specifies the number of bytes that are physically read or written in an I/O operation. The default is 8K. The maximum is 1M.

LRECL=record-length

specifies the record length (in bytes). Under Windows, the default is 256. The value of record-length can range from 1 to 1,048,576 (1 megabyte).

NOTAB

is used only in the context of Dynamic Data Exchange. This option enables you to use non-tab character delimiters between variables. For more information on this option, see “Using the NOTAB Option with DDE” on page 200.

RECFM=record-format

controls the record format. Under Windows, the following values are valid:

F

indicates fixed format.

N

indicates binary format and causes the file to be treated as a byte stream.
P indicates print format.

V|D indicates variable format. This is the default.

Details

The INCLUDE command copies the entire contents of an external file into the active window.

If you do not specify a file-specification, then SAS uses the filename from the previous FILE or INCLUDE command. In this case, SAS first asks you if you want to overwrite the file. If you have not issued any FILE or INCLUDE commands, you receive an error message indicating no default file exists.

See Also

- INCLUDE command in SAS online Help
- “Using the INCLUDE Command” on page 100
- For an example of using some of these options, see “Advanced External I/O Techniques” on page 100.

PMENU

Toggles the command line in the SAS application windows on and off

Windows specifics: Command behavior

Syntax

PMENU <ON | OFF>

no argument

toggles the command lines on and off.

ON

turns the command lines on.

OFF

turns the command lines off.

Details

Even if you use the PMENU command to turn the command lines on, SAS still displays the pull-down menus and pop-up menus that are enabled.
The STORE command copies marked text or graphics in the active window and stores the copy in the Windows clipboard.

Syntax
STORE <LAST | ALL>

LAST
copies only the most recently marked text and unmarks all other marks when more than one area of text is marked. To store one area of text when more than one mark exists, you must use either the LAST or ALL argument.

ALL
stores all current marks when more than one area of text has been marked.

Details
The STORE command copies marked text or graphics in the active window and stores the copy in the Windows clipboard.

The APPEND and BUFFER= options are not supported under Windows for the STORE command.

See Also

- STORE command in SAS online Help
- “Using the Clipboard” on page 36

TOOLCLOSE

Closes the application toolbar

Syntax
TOOLCLOSE
TOOLEDIT

Opens the Customize Tools dialog box

Windows specifics: All

Syntax

TOOLEDIT <library.catalog.entry>

no argument
edits the currently loaded set of tools.

library.catalog.entry
specifies the TOOLBOX entry you want to edit.

Details

The TOOLEDIT command invokes the Customize Tools dialog box with the TOOLBOX entry specified by library.catalog.entry. If a TOOLBOX entry is not specified, the currently loaded set of tools is used.

See Also

- “Customizing the Toolbar” on page 50

TOOLLARGE

Toggles the size of the toolbar buttons

Windows specifics: All

Syntax

TOOLLARGE <ON | OFF>

no argument
toggles the large tool buttons on and off.
ON
turns the large tool buttons on.

OFF
turns the large tool buttons off.

Details
The TOOLLARGE command toggles the size of the toolbar buttons between normal (16x16 pixels) and large (24x24 pixels). You might find the large buttons easier to use with high-resolution displays.

See Also

- “Resetting the Tools to the Default Settings” on page 54

---

**TOOLLOAD**

Loads a specific toolbox

Windows specifics: All

**Syntax**

TOOLLOAD <WINDOW> <BOX | BAR> <libref.catalog.member>

**no arguments**
loads the toolbar for the active window. The tools are displayed as a toolbar or toolbox, depending on the setting in the Customize tools dialog box.

**WINDOW**
associates the toolbox entry you specify with the active window, so the particular set of tools you load apply only to that window. This association lasts until you close the window. If you reopen the window later, the window will revert to its default toolbar.

**BOX | BAR**
controls whether the icons are displayed as a toolbox in a separate window or as a toolbar integrated with the main SAS window.

**libref.catalog.member**
specifies the catalog entry to load. TOOLBOX is the default catalog entry type.

**Details**
After the TOOLLOAD command is processed, the specified toolbox is the active toolbox.
See Also

- “Customizing and Saving a Toolbar for Use with a Particular Application or Window” on page 53

TOOLSWITCH

Toggles the tool switching feature on and off

Windows specifics: All

Syntax

TOOLSWITCH <ON | OFF>

no argument
toggles the tool switching feature on and off.

ON
automatically loads the toolbar (if one is defined) for the active window.

OFF
uses the default toolbar (SASUSER.PROFILE.TOOLBOX) for all windows unless you explicitly load another one.

Details
The TOOLSWITCH command allows you to switch between a toolbar defined for the active window and the SAS default toolbar.

See Also

- “Setting Session Preferences” on page 42
- Command: “DLGPREF” on page 259

TOOLTIPS

Toggles the ToolTips feature on and off

Windows specifics: All

Syntax

TOOLTIPS <ON | OFF>
no argument
toggles the ToolTips feature on and off.

ON
turns the ToolTips feature on.

OFF
turns the ToolTips feature off.

Details
ToolTips are the helpful cues that appear over toolbar buttons, (and over some other controls in the main SAS window) as you position the mouse pointer over them.

The ToolTips command specifies whether the ToolTips text is displayed when you move the cursor over an icon in the toolbox or some other control. If you do not specify ON or OFF, the ToolTips command toggles the text on and off, depending on the current setting.

Note: Do not confuse ToolTips with ScreenTips. ScreenTips display helpful cues for the status line, the window bar, and tabs in the main SAS window.

See Also

- Command: “WSCREENTIPS” on page 285

---

WATTACH

Toggles whether the contents of the active window are attached to an electronic mail message that you initiate using the SAS System

Windows specifics: All

Syntax

WATTACH <ON | OFF>

no argument
toggles the attach mode on and off

ON
specifies to attach the active window

OFF
specifies to not attach the active window

Details
If you specify ON, the contents of the active window are sent as an attached file. For text windows, the format is either text or RTF (as determined by the WEMAILFMT
command or the Preferences dialog box settings). Graphic windows are sent as Windows bitmap (BMP) files. You can also toggle this setting in the Preferences dialog box.

**See Also**

- “Sending Electronic Mail from within the SAS System” on page 139
- Command: “WEMAILFMT” on page 278
- “Setting Session Preferences” on page 42

---

**WATTENTION**

Displays the Tasking Manager window, which allows you to select which SAS process to terminate.

Windows specifics: All

**Syntax**

WATTENTION

**Details**

The WATTENTION command allows you to select a SAS process to terminate. This is the equivalent of pressing CTRL + Break.

---

**WAUTOSAVE**

Controls how often the SAS System automatically saves work in the program editor window.

Windows specifics: All

**Syntax**

WAUTOSAVE <<ON | OFF> INTERVAL=minutes>

no arguments

- turns the autosave feature on and resets the autosave timer (so that work will automatically be saved after the defined time interval).

ON | OFF

- specifies to turn the autosave feature on or off.

INTERVAL=minutes

- Specifies to automatically save work every certain number of minutes. The default interval is 10 minutes. Specify the interval as an integer.
Details
Use the WAUTOSAVE command if you want the SAS System to automatically save your work more often or less often than the default interval of every 10 minutes. SAS save the Program Editor content to ‘pgm.asv’ in the current working directory.

WBROWSE
Invokes your preferred web browser
Windows specifics: All
Syntax
WBROWSE <"URL">  

no argument  
invokes the preferred web browser as defined in the Preferences dialog box Web page.

URL  
specifies a URL (Uniform Resource Locator) which contains the server and path information needed to find a document on the Internet or on a local intranet.

Details
By default, the WBROWSE command invokes the default web browser, which displays SAS Institute's home page (www.sas.com). If you specify a URL then that location is displayed instead. Note that you must enclose the URL in double quotations (".

WCOPY
Copies the marked contents of the active window to the Windows clipboard
Windows specifics: All
Syntax
WCOPY
Details
WCOPY is intended to be used with the toolbar commands. When you enter the WCOPY command and the active window is a text window, the active window's menu is searched for a COPY item. If there is a COPY item, the marked contents is copied to
the Windows clipboard. If there is no COPY item, WCOPY will execute the STORE command for text and the GSTORE command for graphics.

**See Also**

- Command: “STORE” on page 270
- GSTORE command in SAS/GRAPH Software: Reference

---

**WCUT**

Moves the marked contents of the active window to the Windows clipboard

*Windows specifics: All*

**Syntax**

WCUT

**Details**

WCUT is intended to be used with the toolbar commands is valid only when the active window is an editor window, such as the PROGRAM EDITOR window. When you enter the WCUT command, the active window's menu is searched for a CUT item. If there is a CUT item, the marked contents of the active window is moved to the Windows clipboard. If there is no CUT item, WCUT will execute the CUT command.

**See Also**

- Command: “CUT” on page 252

---

**WDOCKVIEW**

Toggles the Docking View feature on and off

*Windows specifics: All*

**Syntax**

WDOCKVIEW <ON | OFF>

*no argument*

toggles the docking view feature on and off.
ON
  turns the docking view feature on.

OFF
  turns the docking view feature off

Details
The docking view allows for easy navigation within the main SAS window. When the
docking view is on, windows that can be docked (integrated with the main SAS window) such as the SAS Explorer and Results windows, display on the left side of the main SAS window. When you click on an item in a docked window that opens another window, such as the output from a procedure listed in the Results window, the window opens on the right side of the main SAS window. You navigate between docked windows using tabs.

See Also

- “Using the Docking View” in the “Interacting with the SAS System under Windows” section of SAS Companion for the Microsoft Windows Environment
- “Using the Docking View” on page 27
- “Setting Session Preferences” on page 42

---

**WEMAILFMT**

Specifies the format to use when attaching the contents of a text window to an electronic mail message

Windows specifics:  All

**Syntax**

WEMAILFMT TEXT|RTF

**TEXT**
  attaches the contents of the current SAS text window as a plain text file.

**RTF**
  attaches the contents of the current SAS text window as a rich text format (RTF) file.

**Details**
  If the current SAS window contains graphics, the contents of the windows are automatically attached as a Windows bitmap file.
WEXITSAVE

Toggles the saving of your settings when you exit SAS

Window specifics: All

Syntax

WEXITSAVE <ON | OFF>

no argument

toggles the saving of your settings when you exit SAS.

ON

saves your settings when you exit SAS.

OFF

do not save your setting when you exit SAS.

Details

You can also toggle this setting in the Preferences dialog box General page.

See Also

“Setting Session Preferences” on page 42

WFILE

Saves the contents of the active window to a file

Windows specifics: All

Syntax

WFILE <REPLACE | APPEND>

If you use the WFILE command with a window that is not associated with a file, the SAS System opens the Save As dialog box. Otherwise, SAS does one of the following depending on the arguments you specify:
no argument
the SAS System prompts you to choose whether to replace or append a file that already exists.

REPLACE
replaces the current file with the contents of the window.

APPEND
appends the contents of the window to the current file.

Details
The WFILE command saves the contents of the active window to a file.

See Also
□ “Saving Window Contents to a File” on page 29

WHIDECURSOR

Suppresses the display of the cursor in SAS windows that do not allow text input

Windows specifics: All

Syntax
WHIDECURSOR <ON | OFF>

no argument
toggles between hiding and displaying the cursor.

ON
hides the cursor.

OFF
displays the cursor.

Details
The WHIDECURSOR command inhibits the display of the default text cursor in windows that do not allow text input, such as those in SAS/ASSIST, SAS/EIS, and SAS/AF software. You can also toggle the WHIDECURSOR setting in the Preferences dialog box Advanced page.
See Also

- “Setting Session Preferences” on page 42

---

**WHSBAR**

Toggles the horizontal scroll bars on and off

Windows specifics: All

---

**Syntax**

WHSBAR <ON | OFF>

no argument
toggles the horizontal scroll bars on and off.

ON
displays the horizontal scroll bars.

OFF
hides the horizontal scroll bars.

**Details**

You can also toggle this setting in the Preferences dialog box.

See Also

- “Setting Session Preferences” on page 42

---

**WININSERT**

Toggles insert mode on and off

Windows specifics: All

---

**Syntax**

WININSERT <ON | OFF>

no argument
toggles the insert mode on and off
ON
   enables the insert mode

OFF
   enables the overstrike mode

Details
You can also toggle this setting by pressing the INSERT key on your keyboard, or by
using the Preferences dialog box.

See Also

□ “Setting Session Preferences” on page 42

WMENUPOP

Toggles the pop-up menus in the SAS application windows on and off

Windows specifics: All

Syntax
WMENUPOP <ON | OFF>

no argument
   toggles the pop-up menus on and off.

ON
   turns the pop-up menus on.

OFF
   turns the pop-up menus off.

Details
By default, the pop-up menus are on. You can access the pop-up menu for a window by
dicking the right mouse button inside the window client area.

When used with the -NOAWSMENU system option, this command makes all menu
selections unavailable to the user. This can be a useful technique when developing
SAS/AF applications in which you want to restrict the actions of the end user.
### WMRU

Retains the names of the most recently used files in the File menu

**Windows specifics:** All

**Syntax**

```
WMRU <<ON> <NUM=number-of-filenames>>| <OFF>
```

**no arguments**

toggles the file list on and off.

**ON NUM=number-of-filenames**

turns the file list on and maintains number-of-filenames filenames in the list. The number-of-filenames argument can be an integer from 1 to 9. If you omit number-of-filenames, SAS maintains four filenames.

**OFF**

turns the file list off.

**Details**

When you open or save a file using the Open or Save As dialog boxes, SAS adds the filename to the list in the `File` pull-down menu. You can open a recently used file in the PROGRAM EDITOR window by selecting its name from the `File` menu. By default, SAS retains four filenames in the list.

You can also configure these settings in the Preferences dialog box.

### See Also

- “Setting Session Preferences” on page 42

---

### WNEWTITLE

Clears the contents of the active window and removes its title

**Windows specifics:** All
Syntax
WNEWTITLE

Details
When you save the contents of a SAS window to a file, SAS assigns the filename as the title of the window. You can use the WNEWTITLE command to clear the active window and remove that title (reverting to "Untitled").

If used in the LOG or OUTPUT window, this command clears the contents of the window and changes the name to "Untitled." If used in the PROGRAM EDITOR window, SAS prompts you to save the contents of the window before clearing it and removing the title.

WPASTE

Pastes the contents of the Windows clipboard into the active window

Windows specifics: All

Syntax
WPASTE

Details
WPASTE is intended to be used with the toolbar commands. When you enter the WPASTE command, the active window's menu is searched for a PASTE item. If there is a PASTE item and the clipboard contains text, WPASTE will execute as if you selected PASTE from the pull-down menu. If the clipboard contains graphics, SAS issues the GPASTE command. If there is no PASTE item, WPASTE will execute the PASTE command.

See Also
- PASTE command in SAS online Help
- GPASTE command in SAS/GRAPH Software: Reference

WPOPUP

Causes the pop-up menus for a window to appear

Windows specifics: All
**Syntax**

WPOPUP

**Details**

You can access the pop-up menu for a window by clicking the right mouse button inside the window client area. By default under Windows, this command is associated with the right mouse button.

**See Also**

- Command: “WMENUPOP” on page 282

---

**WRTFSAVE**

Saves the contents of the current text window to an RTF file

**Windows specifics:** All

**Syntax**

WRTFSAVE "filename" <NOPROMPT>

**filename**

is a required argument and can include a file path. If you specify a filename without a path, the file is saved in the current SAS working folder. The WRTFSAVE command does not automatically append the .RTF file extension. If you want the resulting filename to end in .RTF, be sure to include it as part of the filename that you specify.

**NOPROMPT**

specifies that if a file with the same filename already exists, that file will be overwritten without prompting you with a confirmation dialog box.

**Details**

The WRTFSAVE command saves the contents of the active window in .RTF format. This command performs the same action as the Save As dialog box when you select .rtf from the Save file as type list. However, WRTFSAVE saves the file without displaying an intermediate dialog box.

---

**WSCREENTIPS**

Toggles the ScreenTips on and off
Windows specifics: All

Syntax
WSCREENTIPS <ON | OFF>

no argument
toggles the ScreenTips on and off.
ON
displays helpful cues for the status line, window bar and tabs within the main SAS window.
OFF
turns off the ScreenTips.

Details
ScreenTips are the helpful cues that appear over the status line, window bar and tabs in the main SAS window as you position the mouse pointer over them.
The WSCREENTIPS command specifies whether the ScreenTips text is displayed when you move the cursor over the status line, window bar, or tabs in the main SAS window.

Note: Do not confuse ScreenTips with ToolTips. ToolTips display helpful cues for tools. You can also toggle the ScreenTip setting in the Preferences dialog box View page.

See Also

- Command: “TOOLTIPS” on page 273
- “Setting Session Preferences” on page 42

WSTATUSLN

Toggles the status line on and off, and specifies the area proportions
Windows specifics: All

Syntax
WSTATUSLN <ON | OFF> <ALL | MSG=<percent-msg> | CDIR=<percent-cdir>>

no arguments
toggles the status line on and off.

The first argument is optional, but if you specify it, you must include it before the second group of options:
ON
displays the status line in its most recent active state. If the status line includes a
message area, the message lines in the SAS application windows are disabled. ON is
the default setting.

OFF
turns off the status line. This enables the message lines in the SAS application
windows.

The second group of arguments is also optional. Note that specifying these options
without specifying the ON option first does not automatically turn the status line on if
it is currently off.

MSG<=percent-msg>
includes the message area as part of the status line. If you specify this option
without the CDIR option, the message area occupies the entire status line. If you
specify a percentage with this option and with the CDIR option, the message area
occupies the proportion of the line that you specify.

CDIR<=percent-cdir>
includes the current directory as part of the status line. If you specify this option
without the MSG option, the current directory area occupies the entire status line. If
you specify a percentage with this option and with the MSG option, the current
directory area occupies the proportion of the line that you specify.

ALL
includes both the message area and the current directory areas on the status line. If
you do not specify the MSG and CDIR options with percentage values, the status line
proportions revert to the most recent settings. ALL is the default setting.

Details
The WSTATUSLN command specifies whether the status line of the active window is on
or off and specifies the proportions of the status line that the message area and the
current directory area occupy. You can also toggle the status line in the Preferences
dialog box view page.

Example
To display a status line that is evenly divided between the message display and the current directory

See Also

  □ “Setting Session Preferences” on page 42

WUNDO
Undo the last CUT, COPY, or PASTE toolbar action
Windows specifics: All
Syntax
WUNDO

Details
When you enter the WUNDO command, the active window’s menu is searched for an undo item. If there is an undo item, WUNDO will execute as if you selected UNDO from the pull-down menu. If there is no undo item, WUNDO will execute the UNDO command. Some windows may not have an undo command.

WVSBAR

Toggles the vertical scroll bars on and off
Windows specifics: All

Syntax
WVSBAR <ON | OFF>

no argument
toggles the vertical scroll bars on and off.
ON
displays the vertical scroll bars.
OFF
hides the vertical scroll bars.

Details
You can also toggle this setting in the Preferences dialog box.

See Also

□ “Setting Session Preferences” on page 42

WWINDOWBAR

Toggles the window bar on and off
Windows specifics: All
**Syntax**

```
WWINDOWBAR <ON | OFF>
```

-no argument-

- **ON**
  - displays the window bar in the main SAS window.

- **OFF**
  - does not display the window bar in the main SAS window.

**Details**

If the window bar is on, it displays at the bottom of the main SAS window. SAS windows minimize to the window bar. You can bring a window to the front by clicking on the window’s button in the window bar. To open a file in an open application, you drag the file to the application’s button in the window bar (which brings the application to the front) and then drag the file to the application’s window. When the window bar is off, SAS windows minimize to small title bars.

You can also turn the window bar on or off using the Preferences dialog box `view` page.

**See Also**

- “Customizing Your Windowing Environment” on page 46

---

**X**

Enters host-system mode or allows you to submit a DCL command without ending your SAS session

**Windows specifics:** Valid values for command; syntax

**Syntax**

```
X <"command">
```

- **command**

  - specifies the command that you want to execute.

**Details**

This form of the X command issues one command. The command is passed to the operating environment and executed. If errors occur, the appropriate error messages are displayed.
See Also

- X command in SAS online Help
- “Running DOS or Windows Commands from within SAS” on page 20
- System option: “XCMD” on page 435

---

**ZOOM**

Maximizes the active window

*Windows specifics: All*

---

**Syntax**

ZOOM <ON | OFF>

**ON**

maximizes the active window.

**OFF**

returns the active window to the default size.

---

**Details**

When you maximize one application window, the SAS System windowing environment enters a maximized mode. As you switch between active windows, each window you select will be maximized. When you restore one of the application windows to its original size, all windows are restored.

---

**See Also**

- ZOOM command in SAS online Help